CHAPTER 4

Spatial data management
In the previous chapter you have seen how spatial data is entered in ILWIS via
digitizing. Another method for obtaining spatial data is to convert digital data into
other file formats. Sometimes, you obtain data that might not be directly usable in an
analysis. The data may still need to be edited. The data may be in the wrong data type
for a specific type of analysis. You may have to convert data from one vector type to
another (e.g. from segments to polygons), or from vector to raster (rasterization). The
data may also contain the wrong coordinates, georeference, domain or representation.
In this chapter the various spatial data management operations are shown, which
precede the actual data analysis. The first part of this chapter (section 4.1) deals with
the import of raster and vector maps from different file formats. In section 4.2, the
topic of map projections is treated, and how you can change maps from one
projection to another. In section 4.3, tools for vector data management are shown, and
in section 4.4, the vector to raster conversion is demonstrated. Then in section 4.5, the
tools for the management of raster maps are explained.
The final section 4.6 focuses on the conversion of domains.
Before you can start with the exercises, you should start ILWIS and change to the
subdirectory C:\ILWIS 3.0 Data\Users Guide\Chapter04, where the data files for
this chapter are stored.

☞

•
•

Double-click the ILWIS icon on the desktop.
Use the Navigator to go to directory the C:\ILWIS 3.0 Data\Users Guide\
Chapter04.
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4.1 Importing digital data
In the previous chapter you have seen how to digitize maps. However, sometimes
maps may already be available in digital format from another source. They may have
been generated using different software, they may have resulted from scanning maps,
or they may be available as digital satellite images or scanned images. In order to use
these digital data in ILWIS, the files need to be imported to the ILWIS file formats
that are required. Importing can be done with the Import module, in which you can
select the import method and format.
While importing files into ILWIS, you must know what type of data you are
importing: whether it is a point, segment, polygon or raster map, and what type of
information is stored inside the map. The content of a map determines the domain
type (class, ID, value, image, picture, color, etc.) that will be assigned to the imported
map.
Within ILWIS, you can use the normal ILWIS import, but you can also import
external files via GeoGateway.
GeoGateway is a product of PCI Geomatics (http://www.pcigeomatics.com) which
allows programs to access data in many geomatics file formats, in a uniform manner,
without having to translate them before use in applications. GeoGateway includes
access to imagery, vectors, attributes, projections and other auxiliary information of
interest to users of geomatics applications.
When using GeoGateway, you can choose to:
- perform a genuine import and translate the external file to an ILWIS format:
- the external data will be translated into ILWIS file formats: ILWIS object
definition files (e.g. .MPR, .TBT) as well as ILWIS data files will be created.
- you can view the imported data, calculate with it, use it in ILWIS operations,
etc.
- the imported data can be edited in ILWIS.
- keep the external file in its original format (Use As):
- the external data will not be translated into ILWIS file formats: only ILWIS
object definition files (e.g. .MPR, .TBT) will be created; as the same data file
will not appear twice on your hard disk in different formats, you will save some
hard disk space in this way.
- you can view the imported data, calculate with it, use it in ILWIS operations,
etc.
- the imported data cannot be edited in ILWIS however.
After you used Import via GeoGateway, you will obtain an ILWIS object
collection
. The object collection contains the ILWIS objects that are the result of
the import. You can open an object collection by double-clicking it in a Catalog; you
can subsequently open the imported objects also by double-clicking.
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4.1.1 Importing raster data through ILWIS import
Raster maps can be imported from a number of file formats. Some of these formats
do not allow the storage of coordinates. This is the case for the frequently used file
interchange formats: Tag Image File (TIF) format, and the Windows Bitmap (BMP)
format. When you import a raster map from these formats, the resulting ILWIS map
will have a georeference None . This means that the map is not georeferenced.
The TIF file format is frequently used as the storage type for scanned images. Here
an example is shown of importing a scanned aerial photograph of the city of
Cochabamba.

☞

•

From the File menu of the Main window, select Import, Map. The Import
dialog box is opened. Click the Help button if you like.

•
•

Select the Import Format: Tagged Image File Format .TIF .

•
•
•

Select the file: Airphoto.tif , leave the Output Filename as it is and
click OK. The map Airphoto is now imported.
Open the raster map Airphoto and check that it doesn’t have coordinates.
From the File menu of the map window, select Properties, and 1 map
Airphoto . The Properties sheet is opened.
Check the size of the map and the domain and close the Properties sheet
and the map window afterwards.

As you can see the import of black and white TIFF images, results in an image
domain for the output map.
When you import a TIFF image, the domain of the imported image depends on the
storage type of the TIFF file. ILWIS can import raster data with 1 bit/pixel (into
domain bit), 4 or 8 bits/pixel (into domain image), 4 or 8 bits/pixel with a color
lookup table (into domain picture), up to 24 bits per pixel (RGB, into domain color).
The same is true for files that are in Windows bitmap format (.BMP).
The user has no control over the selection of output domains of these maps. Methods
to convert domains of maps are explained in section 4.6.
Now some examples of importing Windows bitmap files will be shown: one of a
map showing the country of Bolivia (Bolivia_mask) . The other map is a
hillshading image of Bolivia and its surroundings (Hillshad ) with 8 bits/pixel, with
a color lookup table, resulting in an ILWIS map with a picture domain.

☞

•

From the File menu of the Main window, select Import, Map. The Import
dialog box is opened.

•
•

Select the Import Format: Windows bitmap .BMP .
Select the file: Bolivia_mask.bmp . Leave the Output Filename as it is
and click OK. The map Bolivia_mask is now imported.
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•
•

Import also the Windows bitmap Hillshad .

•

Close the map windows. The maps will be used later on.

Open the raster maps Bolivia_mask and Hillshad and check the domain
types and other properties of both maps.

Other file formats, such as the ERDAS .GIS, ERDAS .LAN and IDRISI .DOC/.IMG,
also allow for the conversion of coordinate information. The conversion of these file
formats will result in maps with a georeference corners.

4.1.2 Importing raster data through GeoGateway
To import external raster file formats in ILWIS, you can use the normal ILWIS
Import, but you can also Import via GeoGateway, which supports many current
raster file formats. The result of a GeoGateway import is an ILWIS object collection.
In this exercise, you will import an ERDAS .IMG file using GeoGateway and convert
this data to ILWIS data format. This file contains a Landsat TM image of
Cochabamba. The result will be an object collection, containing a map list and 3
different bands (raster maps).

☞

•

Expand the Import/Export item in the Operation-tree, and double-click
Import Via GeoGateway. The Import dialog box is opened.

•
•

Select the file: Tm_b123.img .

•
•

Accept the Output Filename Tm_b123 .

•
•

Double-click the object collection Tm_b123 . The object collection is opened.

•

Close the object collection and the map windows after you have finished the
exercise.

Make sure the option Use PCI-GeoGateway is selected in the Import
Format list box.
Select the check box Convert to ILWIS data format and click OK. The map
Tm_b123.img is now imported.
Open the maps to see the contents. Check the domain types and other properties of the maps.

In the next exercise you will import an IKONOS image with a 1 meter resolution. As
this file is almost 90 MB, we will use the Use As option (see section 4.1). The file is
furthermore in GeoTiff format so that coordinates will be preserved. You will obtain
an object collection which contains a map list and the definitions of three bands.
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☞

•

From the File menu of the Main window, select Import, Via GeoGateway.
The Import dialog box is opened.

•
•

Select the file: Ikonos_Cochabamba.tif .

•
•

Click OK. The Ikonos_Cochabamba.tif file is now imported.

•

Double-click the map list in the object collection and click the Open As
ColorComposite button. The Display Options – Map List as
ColorComp dialog box appears.

•

Select image Ikonos_Cochabamba__3 for the Red Band,
Ikonos_Cochabamba__2 for the Green Band and Ikonos_
Cochabamba__1 for the Blue Band.

•

Adapt the default stretch values to 1% intervals. For the minimum and the
maximum stretch values, use for the Red Band 36 and 328 , for the Green
Band 37 and 332 , and for the Blue Band 39 and 338 . Click OK.
The interactive color composite is shown in a map window.

•

Zoom in on the image; close the map window, the map list and the object
collection after you finished the exercise.

Make sure the option Use PCI-GeoGateway is selected in the Import
Format list box, leave the Output Filename as it is, clear the check box
Combine compatible vector layers, and make sure that the check box
Convert to ILWIS data format is cleared.
Double-click the object collection Ikonos_Cochabamba . The object
collection is opened.

4.1.3 Importing through General Raster Import
Import General Raster is designed to import raster map formats which are not
directly supported by ILWIS nor by GeoGateway. Files to be imported may have a
band sequential structure, a band interleaved structure or a pixel interleaved structure.

This option does not automatically read the header line of the file that normally
contains information about the map's dimensions, coordinates, data type, etc.
The user is asked to enter required information manually, therefore you should have
some knowledge about the header size and the structure of the file.
In this exercise, a global 30 Arc Second Elevation Data file will be imported which is
part of a global Digital Elevation Model. The file covers part of South America.

!

This file has been downloaded from the USGS EROS Data Center at
http://edcdaac.usgs.gov/gtopo30/gtopo30.html. As exercise material it is also
available on the ILWIS CD-ROM and the ILWIS web site.
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☞

•

Expand the Import/Export item in the Operation-tree, and double-click
Import General Raster. The Import dialog box is opened.

•
•

Select the file: W100S10.DEM .

•

Accept the Output Filename W100S10 and click OK. The Import General
Raster dialog box is opened.

•
•
•
•
•
•

Type 0 for Header Size.

Make sure the option Use General Raster Import is selected in the Import
Format list box.

Select 1 for Number of Bands.
Type 4800 for Number of Columns.
Select Integer numbers for Pixel Structure.
Select 2 for Number of bytes per pixel.
Select the check box High Endian Byte Order.

If you would like to edit the contents of the map, you need to convert the data file to
ILWIS data format. In this case, you will not edit the map nor use it in another
exercise. Therefore it is sufficient to use the data file in the original file format.

☞

•
•

Make sure that the check box Use data file in original format is selected.

•

Open the map to see its contents.

Accept the Output Name W100S10 and click OK. The map W100S10.DEM
is now imported.

The map window shows part of the continent of South America. The imported map
has system domain value. When moving the mouse pointer in the map window, you
will see that the map has no coordinates. Before you can use this imported map
together with other data in ILWIS, you need to create a georeference for the map.

☞
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•
•

Close the map window.

•
•
•
•
•
•
•

Type for the GeoReference Name W100S10 .

In the Main window, open the File menu and select Create, GeoReference.
The Create GeoReference dialog box is opened.
Accept the GeoRef Corners option.
Select the Coordinate System LatLonWGS84 .
Type for Pixel size 0º 0’ 30’’.
Type for Min Latitude 60º 0’ 0’’ S.
Type for Min Longitude 100º 0’ 0’’ W.
Type for Max Latitude 10º 0’ 0’’ S.

➥
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•
•

Type for Max Longitude 60º 0’ 0’’ W.

•

In the Catalog, click with the right mouse button on raster map W100S10
and select Properties from the context-sensitive menu. The Properties
sheet is opened.

•
•

In the Properties sheet, select GeoReference W100S10 and click OK.

Make sure the option Center of Corner pixels is not selected and click OK.
The georeference is created.

Open the map W100S10 and check the coordinates.

Raster map W100S10 is now displayed with the proper coordinates and can be used
in combination with other data in ILWIS.
Note that pixels in the ocean area have a value –9999 , which indicates that there is
no data available, while in ILWIS this should be undefined. You can correct the map
with a Map Calculation in which you replace value –9999 by “?”.

☞

•

Type the following formula on the Command line of the Main window:
CorrectDEM = IFF(W100S10=-9999,?,W100S10) ↵

•
•

The map is calculated and the Raster Map Definition dialog box is opened.

•

Close all map windows after you have finished the exercise.

Accept the defaults in the Raster Map Definition dialog box and click OK.
The output map is now displayed with undefined values where no data is
available, and with a proper stretch for elevation data.

4.1.4 Importing vector data through ILWIS import
The most frequently used file formats for importing vector data in ILWIS, are the
ArcInfo .E00 (non-compressed) format, the ArcView .SHP format and the AutoCad
.DXF format.
The conversion from ArcInfo .E00 format depends on the contents of the file, and
will either result in a segment map, possibly with a point map containing polygon
labels, or a polygon map. The domain will always be identifier.
In this exercise, you will import an ArcInfo .E00 file which contains the entire
drainage network of Bolivia. The file, Dnnet.E00 , is part of the Digital Chart of the
World and has been downloaded from the Digital Chart of the World Server at Penn
State University Libraries at http://www.maproom.psu.edu/dcw. The import will
result in an ILWIS segment map and an attribute table.
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☞

•

From the File menu of the Main window, select Import, Map. The Import
dialog box is opened.

•
•

Select the Import Format: Arc/Info .E00 interchange format.

•

Open the Properties sheet of segment map Dnnet , and change the
coordinate system to Latlon . The coordinates in this drainage map are
geographical coordinates.

•

Display the segment map Dnnet , check the names of the segments, and
check the coordinates.

•

If you like, add segment maps Contour and Drainage to the map window,
and zoom in.

•

Close the map window when you are finished.

Select the file: Dnnet.E00 . Accept the Output Filename and click OK.
The map Dnnet.E00 is now imported.

The conversion from AutoCad .DXF may be a segment map, a polygon map and/or a
point map, depending on the contents of the file. If the codes in the .DXF file only
contain numerical values (as is the case for contour lines), the output domain will be
value. Otherwise it will be a class domain (if there is more than 1 code).
In this example a map of South America, in AutoCad .DXF format (Samerica ),
will be imported as a polygon map with a class domain. Note that in this case each
polygon has a separate boundary line, without topology.

☞

•

From the File menu of the Main window, select Import, Map. The Import
dialog box is opened.

•
•

Select the Import Format: AutoCad .DXF .
Select the file: Samerica.dxf . Leave the Filename as it is and click OK.
The map Samerica is now imported.

•

Open the Properties sheet of the polygon map Samerica , and change the
coordinate system to LatLon . The coordinates in this map are geographical
coordinates.

•

Display the polygon map Samerica , check the coordinates and the names
of the polygons and close the map window after you have finished the exercise.

4.1.5 Importing vector data through GeoGateway
External vector file formats can be imported using the normal ILWIS Import, but
you can also import vector files through GeoGateway, which supports many current
vector file formats. The result of a GeoGateway import is an ILWIS object collection.
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☞

•

From the File menu of the Main window, select Import, Via GeoGateway.
The Import dialog box appears.

•
•

Select the file: Cochabamba.pix .

•

Clear the check box Combine compatible vector layers and click OK.
The Cochabamba.pix file is now imported.

•

Double-click the object collection Cochabamba . The object collection is
opened.

•

Open the map list and click the Open As ColorComposite button. The
Display Options – Map List as ColorComp dialog box appears.

•

Select image Cochabamba__4 for the Red Band, Cochabamba__3 for
the Green Band and Cochabamba__2 for the Blue Band.

•

Adapt the default stretch values to 1% intervals. For the minimum and the
maximum stretch values, use for the Red Band 7 and 74 , for the Green
Band 9 and 71 , and for the Blue Band 10 and 49 . Click OK.
The interactive color composite is shown in a map window.

•

Drag and drop the segment layers on top of the color composite and close the
map window, the map list and the object collection after you finished the
exercise.

Make sure the option Use PCI-GeoGateway is selected in the Import
Format list box and leave the Output Filename as it is.

For more information on the import of vector and raster data, see the ILWIS Help.
Summary: Importing data
- Raster maps can be imported from a number of file formats. Some of these formats
do not allow for the storage of coordinates, for instance the Windows Bitmap
(.BMP) format. The Tagged Image File format (.TIF) only stores coordinates
when it has been exported as GeoTIFF. Other file formats, such as the ERDAS
.GIS, ERDAS .LAN, and the IDRISI .DOC/.IMG generally contain coordinate
information.
- Frequently used file formats for importing vector data into ILWIS are the Arc/Info
.E00 format, the Arc/View .SHP format and the AutoCad .DXF format.
- To import external raster and vector file formats into ILWIS, you can use the
normal ILWIS Map Import, but you can also Import via GeoGateway, which
supports many current raster and vector file formats.
- Import General Raster is designed to import raster maps which formats are not
directly supported by ILWIS nor by GeoGateway. Files to be imported may have a
band sequential, a band interleaved, or a pixel interleaved structure.
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4.2 Map projections
The maps that you obtain after importing, often need to be changed before you can
use them in combination with the rest of your data. The different tools that you can
use to change vector and raster maps will be explained in the rest of this chapter. One
of the most important changes that may have to be done is related to the coordinates
of the map. The map may not have coordinates (in the case of raster maps imported
from TIFF or BMP for example). In that case you will have to georeference and
resample so that they have equal dimensions, pixel size and projection as the other
maps. Also, for vector maps, which have coordinates by definition, these coordinates
may not be the ones that you use for other maps. In that case you will need to
transform the coordinate system. The most important reason that coordinates may be
different (apart from the fact that a local coordinate system may have been used), is
that the original maps had different projections.
A map projection defines the relationship between the map coordinates and the
geographic coordinates, latitude and longitude.
The geographic coordinate system is a spherical coordinate system composed of
parallels of latitude (φ) and meridians of longitude (λ) (see Figure 4.1.A).

Figure 4.1:

A: Geographic coordinate system: The location of A is determined by the longitude
(λ) and the latitude (φ). B: The relationship between a sphere with radius a and an
ellipse with major and semi-axis a and b

Because of the earth’s rotation, the shape of the earth is not a perfect sphere. The
earth is flattened towards the poles: The equatorial axis (line from the center to the
equator) is longer than the polar axis. The earth’s shape can be represented by an
ellipsoid, or as it is sometimes called, a spheroid (shapes that are generated by
revolving an ellipse around its minor axis).
A spheroid has 2 different semi-axes a and b, where a is the radius of the equator
circle and b is the half axis of rotation ( b < a). See Figure 4.1B.
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The flattening of the ellipsoid is defined by:
f = (a-b)/a

and the eccentricity:
e*e = (a*a - b*b) / a*a

It follows that the ellipsoid shape is also completely defined by a and f or by a and e.
Nearly 93% of the earth’s land surface is mapped using only four of these ellipsoids:
International, Krassovsky, Bessel and Clarke (1880). Table 4.1 lists the ellipsoids
available in ILWIS. They are stored in text file Ellips.def . In this file, for each
ellipse the value of a (equatorial radius) and 1/f (the inverse of the flattening) are
listed.
If no ellipsoid is known, the choice by default is a sphere with a = b = 6371007 m.
The choice of the ellipsoid, which fits best a given region of the earth’s surface to be
mapped, depends on the surface curvature and geoid undulations in that region.
Hence every country has its own “best” ellipsoid. See also the ILWIS Help topic
Select Ellipsoid.
Table 4.1:

Reference ellipsoids, which can be chosen in ILWIS.

Airy 1830
ATS 77
Australian National
Bessel 1841
Bessel 1841 (Japan by Law)
Bessel 1841 (Namibia)
Clarke 1866
Clarke 1880
Clarke 1880 (IGN)
D-PAF (Orbits)
Everest (India 1830)
Everest (India 1956)
Everest (Malaysia 1969)
Everest (E. Malaysia and Brunei)
Everest (Malaysia and Singapore 1948)
Everest (Pakistan)
Everest (Sabah Sarawak)

Fischer 1960
Fischer 1968
GRS 80
Helmert 1960
Hough 1960
Indonesian 1974
International 1924
Krassovsky 1940
Modified Airy
Modified Fischer 1960
New International 1967
SGS 85
South American 1969
WGS 60
WGS 66
WGS 72
WGS 84

The surface of the earth is curved but this should be presented in maps as a plain
surface. This will always result in some deformation or distortion, unless you use a
spheroidal map (a globe). To correctly represent the curved earth’s surface on a flat
map, you need a special map projection. With the help of a map projection,
geographic coordinates are converted into a two dimensional metric coordinate
system, measuring the X and Y directions in meters. Each map projection has unique
equations for the transformation from geographic to metric coordinates.
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Map projections can be subdivided according to three aspects: class, aspect and
properties.
There are three classes of map projections:
- Cylindrical projections
Cylindrical projections may be imagined, as the transformation to a plane that is
wrapped around the globe in the form of a cylinder (see Figure 4.2). Note that it is
possible that the cylinder intersects the sphere (a secant cylinder). The outline of the
world map would be rectangular in shape.
- Azimuthal projections
These projections may be imagined as the transformation on a plane tangent to the
globe (Figure 4.2). As with the cylindrical projections, here the plane may intersect
the sphere (a secant plane). The characteristic outline of the world map would be
circular.
- Conical projections
These projections may be imagined as the transformation to a plane that is wrapped
like a cone around the globe (Figure 4.2). The possibility of a secant cone is also
present in this class. The outline of the world would be fan shaped.

Figure 4.2:

Cylindrical, azimuthal and conical projections. For each projection a tangent (touching the globe), and a secant (intersecting the globe) version is shown. The lower
right part of the figure illustrates two aspects: Normal (oriented parallel to the
earth’s axis) and transversal (oriented perpendicular to the earth’s axis)

Projections can also be subdivided according to their aspect: The direction in which a
cylinder, plane or cone is oriented with respect to the globe. In Figure 4.2 two
possibilities are given: Normal and transverse aspects. For cylindrical projections a
normal aspect is a cylinder that touches the equator. A transverse aspect is a cylinder
that touches the poles. Similarly the normal and transverse aspects of azimuthal
projections can be visualized. The aspect may also be oblique; in that case the
cylinder, plane or cone is not horizontally or vertically oriented, but something in
between.
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Another important way to subdivide map projections is according to their properties.
As mentioned before, a map projection always results in some deformation or
distortion. Depending on the type of projection, these distortions will be different.
This is indicated by the so-called special properties. The most important properties
are:
- Conformality: A conformal map is one in which all angles are indicated correctly.
All angles measured on the earth’s surface are measured with the same values in
the map. As all angles are maintained, the shape of the objects is also preserved.
- Equivalence: A map with an equivalence property is called an equal-area map.
Although the shape of objects is distorted, the area as measured on the globe is
correctly indicated on the map.
- Equidistance: An equidistant map has the characteristic that along a special set of
lines, distances are equal.
Map projections are named according to the class, the aspect, the property, the name
of the originator and the nature of any modification. In Table 4.2 an overview is given
of the projections available in ILWIS.
Now we will take a look at some map projections and see how the map of the world
is displayed.

☞

•
•

Open the segment map World .
Click the Add Graticule option in the Layers menu. The Display Options Graticule dialog box is opened.

•

Type 20° for Graticule Distance, accept all other defaults and click OK.
The graticule is now added to the map window, showing parallels and meridians every 20º.

•

In the map window, open the File menu, choose Properties and select the
segment map World . Check the coordinate system on the Segment Map
tab of the Properties sheet.

•

Close the Properties sheet.

Now the effect of several map projections on the display of the world map will be
demonstrated. For each projection a new coordinate system should be created.

☞

•
•
•
•
•

Drag the map window to the side of the screen.
In the Main window, open the File menu and select Create, Coordinate
System. The Create Coordinate System dialog box is opened.
Type for the Coordinate System Name: Centcyl .
Type for the Description: Using the central cylinder projection .
Select CoordSystem Projection and click OK. The Coordinate System
Projection dialog box is opened.
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•
•

Click the Projection button.
Select the projection: Central Cylindrical and click OK.

The Coordinate System dialog box now displays more information, relevant for this
projection. The central cylindrical uses the equatorial radius of the earth, since the
cylinder touches the earth at the equator. See Figure 4.2.
The false easting, false northing and central meridian are used to define the X, Y
coordinates of the map. False easting: Overall increase of map x-coordinates
(‘eastings’), indicating the eastward shift of the origin of the projection relative to the
redefined origin (negative if projection origin is west of false origin). False northing:
Overall increase of map y-coordinates (‘northings’), indicating the northward shift of
the origin of the projection relative to the redefined origin (negative if projection
origin is south of false origin). We won’t change them now.

☞

•

Type some positive values for Max X,Y. These coordinates will be adapted
automatically, based on the map displayed in the map window.

•
•

Click OK in the Coordinate System dialog box.

•
•

Note how the World map and the 20º graticules change.

Drag and drop coordinate system Centcyl to the map window in which the
map World is displayed.
Zoom in on the central part of the world, around the equator.

The map you see is neither conformal nor equal area. It is projected perspectively
from the center of the earth onto a cylinder tangent to the equator (see Figure 4.2).
The equator and other parallels are straight lines (spacing increases towards the poles)
and meet meridians (equally spaced straight lines) at right angles. Parallel spacing
increases towards the poles. The poles cannot be shown. Scale is true along the
equator. Shape, area and scale distortion increases rapidly away from the equator.
This map projection only shows the areas surrounding the equator correctly. All other
areas are too much distorted.

☞
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•

Create another coordinate system projection: Lambert_AEA . Select the
projection: Lambert Azimuthal Equal Area .

•

Type some positive numbers for Max X Y. These coordinates will be adapted
automatically, based on the map displayed in the map window.

•
•

Enter for the Sphere Radius: 6356007 and click OK.
Drag and drop coordinate system Lambert_AEA to the map window
displaying the map World .
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Table 4.2:

Some of the projections available in ILWIS. See for other projections and descriptions also the ILWIS
Help topics Select projection and Suggested projections.

Projection

Remarks

Cylindrical

Cassini

Map is equidistant. Used in ellipsoidal form for topographic mapping of Great Britain
before the 1920’s (supposedly Airy ellipsoid) and detailed mapping of German states in the
same period; also used for topographic mapping of France in the 18th century.

Central Cylindrical

Map is perspective but neither conformal nor equal area. Projected perspectively from the
center of the earth onto a cylinder tangent to the equator. Only used for teaching purposes.

Eckert I

Pseudo-cylindrical projection. Map has equally spaced parallels and is neither conformal
nor equal area. Used for showing straight line equal-area graticule.

Eckert II

Pseudo-cylindrical projection. Map is equal area. Meridians are equally spaced straight
lines broken at the Equator. Used for showing straight line equal-area graticule.

Eckert III

Pseudo-cylindrical projection. Map has equally spaced parallels and is neither conformal
nor equal area. Used for showing straight line equal-area graticule.

Lambert Cylind
Equal Area

Also called Cylindrical Equal Area. Mainly used for educational purposes.

Mercator

Conformal. Designed for navigational use; standard for marine charts. Recommended use
for conformal mapping of regions predominantly bordering the equator. Often inappropriately used as a world map.

Miller

Compromise between Mercator and other cylindrical projections. Used in numerous world
maps.

Mollweide

Pseudo-cylindrical projection. Map is equal area. Occasionally used in thematic world maps.

Oblique Mercator

Map is conformal. Oblique aspect of Mercator. Used for larger scale mapping in
Switzerland, Madagascar and Borneo, and for atlas maps of regions having a greater
extent in an oblique direction, such as Hawaii.

Plate Carree

Also called Simple Cylindrical or Equidistant cylindrical. Used for raster maps which store
information of the whole world: Each pixel represents a square block of LatLon coordinates, i.e. information is stored per degree, per minute, etc. Used for mapping the earth
taken as a sphere.

Plate Rectangle

Also called EquiRectangular. Variant of Plate Carree. Used for raster maps which store
information of the whole world: Each pixel represents a rectangular block of LatLon coordinates.

Robinson

Pseudo-cylindrical projection for world maps compromising distortion. Map is neither conformal nor equal area. Used for world maps, for example, by Rand McNally in Goode’s
Atlas for thematic world maps. Only used in spherical form.

Transverse Mercator

Also called Gauss Conformal, or Gauss Krüger. Transverse form of the Mercator Projection
(conformal). Used for many topographic maps at scales from 1: 20000 to 1: 250000.
Recommended for mapping regions that are predominantly north-south in extent.

UTM

Universal Transverse Mercator. Map is conformal. Widely used for topographic maps and
military maps.

Azimuthal

Azimuthal Equidistant Commonly used in the polar aspect for maps of polar regions and the Northern and
Southern hemispheres. The oblique aspect is frequently used for world maps centered on
important cities and occasionally for maps of continents.
Gnomonic

Map is perspective and neither conformal nor equal area. It is used to show great circle
paths as straight lines and thus to assist navigators and aviators.

Hammer Aitoff

Hammer Aitoff Equal Area, variant of Lambert Azimuthal Equal Area.

Lambert Azimuthal
Equal Area

Used for maps of continents and hemispheres. Also suited for regions extending equally in
all directions from a center point, such as Asia and the Pacific Ocean.

Orthographic

Known by Egyptians and Greeks 2000 years ago. Map is perspective and neither conformal nor equal area. Only one hemisphere can be shown. The earth appears as it would on
a photograph from space.
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Table 4.2

continued:

Projection

Remarks

Stereographic

Apparently invented by Hipparchus (2nd century bc). Used in combination with UTM projection as Universal Polar Stereographic (UPS) for mapping poles and in navigation charts for
latitudes above 80°. Recommended for conformal mapping of regions that are approximately circular in shape. For example, used for topographic maps of the Netherlands.

UPS

Universal Polar Stereographic. Azimuthal and perspective projection. Map is conformal.
Used in combination with UTM projection as Universal Polar Stereographic (UPS) in Arctic
and Antarctic maps and in navigation charts for latitudes above 80°.

Conical

Albers Equal Area
Conic

If the pole is one of the standard parallels, it is equal to Lambert’s Equal Area Conic.
Frequently used for maps of the United States, for thematic maps and for world atlases.
Recommended for equal area maps of regions that are mainly east-west in extent.

Bonne

Pseudo-conic projection. Map is equal area. Frequently used until mid-20th century for atlas
maps of continents and for topographic mapping of some countries.

Equidistant Conic

Also called Simple Conic. The most common projection in atlases for small countries.

Lambert Conformal
Conic

Lambert Conformal Conic/Conical Orthomorphic (Lambert, 1972) (conformal). Extensively
used for large-scale mapping of regions predominantly east-west in extent. Further widely
used for topographic maps.

Polyconic

or American Polyconic (Hassler, ± 1820). Map is neither conformal nor equal area. The sole
projection used for large scale mapping of the United States by the USGS until the 1950’s.

Other projections

Dutch RD

Dutch topographic map projection. Map is conformal. The stereographic projection of the
Netherlands is a so-called double projection. The datum Rijksdriehoeksmeting, which
implies the Bessel 1841 ellipsoid, will be used automatically.

Gauss-Boaga (Italy)

Country projection. Transverse Mercator used in topographic maps of Italy.

Gauss (Colombia)

Country projection. Transverse Mercator used in topographic maps of Colombia.

Gauss-Krüger
(Germany)

Country projection. Transverse Mercator used in topographic maps of Germany.

General Perspective

Shows the earth as seen from space. Projection is perspective.

Lambert Conformal
Conic (France)

Country projection. Lambert conformal conic projection used in topographic maps of
France.

Sinusoidal

used since 16th century. Also called Mercator Equal Area. Pseudo-cylindrical projection.
Map is equal area. Used in atlas maps of South America and Africa. Occasionally used for
world maps. Modifications are called Sinusoidal Interrupted, Sinusoidal 2x Interupted and
Sinusoidal 3x Interrupted.

Van der Grinten

Shows the entire earth within one circle. All areas, shapes and angles are greatly distorted.

You will see that the world is projected in a circular way on a plane which touches the
earth at 0 degrees latitude and longitude. Therefore, the equator and the 0 degrees
meridian are straight lines.

☞

•
•
•
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Open coordinate system: Lambert_AEA .
Enter for the Central Meridian: 60º 00’ 00’’ W and for the Central
Parallel: 20º 00’ 00’’ N and click OK.
Press the Redraw button in the map window.
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Now the projection is such that the plane touches South America. The equator is no
longer a straight line. Only the 60º W meridian is now a straight line.
Now the effect of a conical projection will be demonstrated.

☞

•

Create another coordinate system: Lambert_CC . Select the projection:
Lambert Conformal Conic .

•

Type some positive numbers for Max X, Y, enter for the Sphere Radius:
6356007 and click OK.

•

Drag and drop coordinate system Lambert_CC to the map window displaying the map World and zoom in on the centre of the map.

Now only the area surrounding the North Pole is displayed, in a very distorted way.

☞

•
•
•
•
•
•

Open coordinate system: Lambert_CC .
Enter for the Central Meridian: 20º 00’ 00’’ W.
Enter for the Central Parallel: 50º 00’ 00’’ S.
Enter for the Standard Parallel 1: 40º 00’ 00’’ S.
Enter for the Standard Parallel 2: 60º 00’ 00’’ S.
Click OK and press the Redraw button in the map window.

The Southern Hemisphere is now shown in a conical projection.
Some projections will also be shown that are useful for displaying world maps.

☞

•

Create another coordinate system: Orthographic . Select the projection:
Orthographic .

•

Type some positive numbers for Max X, Y, enter for the Sphere Radius:
6356007 and click OK.

•

Drag and drop coordinate system Orthographic to the map window displaying the map World .

The world map is now displayed as if you look at the earth from space.

☞

•
•
•
•

Open coordinate system: Orthographic .
Enter for the Central Meridian: 90º 00’ 00’’ E.
Enter for the Central Parallel: 30º 00’ 00’’ N.
Click OK and press the Redraw button in the map window.

You will now see the continent of Asia.
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☞

•

See the effect of the Plate Carree , the Mercator , the Mollweide and
the Sinusoidal projection.

•
•

Try also other projections, if you like.
When finished, close the map window.

Up to now you have only seen the different projections displayed on the screen. To
actually transform the map, you need to use the Transform Segment operation in
this case, since the map world is a segment map. For points you use the Transform
Points, and for polygons the Transform Polygons operation. They work basically
the same.

☞

•

In the Catalog, click segment map World with the right mouse button and
select Vector Operations, Transform Segments. The Transform
Segment Map dialog box is opened.

•
•

Select the (target) Coordinate System: Lambert_AEA .

•
•
•

Click OK. The map is displayed.

Type for Output Segment Map: World_Lambert_AEA and click the
Show button. The segment map World_Lambert_AEA is created and the
Display Options – Segment Map dialog box is opened.
Add a graticule to the map window and look at the effect.
Close the map window when you are finished.

The UTM projection
There is one map projection that will be treated in more detail, which is the
projection used most in GIS and image processing for relatively small study areas.
The Universal Transverse Mercator (UTM) projection system was developed in the
late 1940s by the US Army. Since then, it has become a standard in topographic
mapping. The UTM comprises the following features:
- The projection is the “Gauss- Krüger” version of the Transverse Mercator.
- The projection is only intended for mapping between 84° N and 80° S. Beyond that
there is too much distortion.
- The unit of measure is the meter.
- The world is divided into 60 zones of 6° of longitude in width. Zone 1 has its
western edge at the 180° meridian. Zone 60 has its eastern edge on the same
meridian. Consequently the zones are numbered from west to east. The zones are
shown in Figure 4.3. Cochabamba is located 66° 08’ 52” W in longitude, and 17°
23’ 30” S in latitude. So it is located on the boundary between UTM zones 19 and
20.
- A second zoning is made along the latitudes following 8° intervals (except for the
most northern zone that has an interval of 12°). These zones have a better designation
from south to north (see Figure 4.3). So Cochabamba is located in zone 19K.
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- The origin of each zone is located on a point at the equator, where it is intersected
by the central meridian of that zone.
- The Easting of the origin of each zone is assigned a value 500,000 m.
- Each zone has its own coordinate system.

Figure 4.3:

UTM grid zone designations for the world, shown on an equidistant
cylindrical projection index map.

- The UTM has a special convention for recording the Northings. For the Southern
Hemisphere the equator is assigned the value 10,000,000. For the Northern
Hemisphere the value at the equator is assigned as 0.
- The UTM might use one of the following definitions of the shape of the earth:
International Spheroid, Clarke 1866 (Africa), Clarke 1880 (North America),
Everest or Bessel (both for smaller parts of Southern and South East Asia).
One of the objections to the introduction of the UTM map projection, was the method
of dividing the world into 60 zones. A country was likely to be divided into several
UTM zones, each having its own coordinate definition and origin. Still the UTM
system was accepted worldwide. Many maps show the coordinates of the national
system as well as those of the UTM.
For large scale mapping, if an area lies within more than one UTM zone, the entire
area has to be mapped as if it lies in that zone. One should select the zone that
occupies the major part of the area, extending the borders of the zone over the +3°
and -3° boundaries.
Likewise, if the country covers both sides of the equator, the coordinates from the
Southern Hemisphere are extended for the part on the Northern Hemisphere (so
larger than 10,000,000).
The data on the projection used should be found on the topographic map, from which
you have digitized the information. On the topomap of Cochabamba, the following
information is given:
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☞

Ellipsoid: International.
Projection: Transverse Mercator.
Vertical Datum: Sea level.
Horizontal datum: Provisional South America 1956.
UTM zone: 19 K.

•
•

Open the coordinate system: Cochabamba .

•

Click the Datum button and select the Datum: Provisional South
America 1956 , select the Area: Bolivia and click OK.

•
•

Clear the check box Northern Hemisphere.

Click the Ellipsoid button and select the Ellipsoid: International 1924
and click OK.

Enter for the (UTM) Zone: 19 and click OK in the Coordinate System
Projection dialog box.

Suppose you want to convert data from the Cochabamba area from UTM zone 20 to
UTM zone 19. To illustrate the transformations you first create a coordinate system
for the adjacent UTM zone 20.

☞

•

Open the File menu in the Main window and select Create, Coordinate
System. The Create Coordinate System dialog box is opened.

•

In the Create Coordinate System dialog box type Cocha20 for the
Coordinate System Name, select the option CoordSystem Projection
and click OK. The Coordinate System Projection dialog box appears.

•
•

Enter some positive values for Max X, Y and click the Projection button.

•

Click the Ellipsoid button, select the Ellipsoid: International 1924 and
click OK in the Select Ellipsoid dialog box.

•

Click the Datum button and select the Datum: Provisional South
America 1956 , the Area: Bolivia and click OK.

•
•

Clear the check box Northern Hemisphere.

In the Select Projection dialog box, select the Projection: UTM and click
OK.

Enter for the UTM Zone: 20 and click OK in the Coordinate System
Projection dialog box.

Now that a new coordinate system is made for UTM zone 20, you can link this
coordinate system to the maps digitized in that projection.
Checking coordinate transformation
Before making a coordinate transformation, it is wise to check the transformation for a
few coordinate pairs. This can be done with the Transform Coordinates dialog box.
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The following steps have to be done:
- Select a certain point on one of the paper maps and note its X and Y coordinates.
- Determine this point on the other paper map and note its X and Y coordinates.
- Enter one of the coordinate pairs in the ILWIS Transform Coordinates dialog box
as the following:

☞

•

Double-click the Transform Coordinates operation in the Operation-list.
The Transform Coordinate dialog box is opened.

The options in this box can be used to check whether the transformation is correct. It
allows you to select an input and output coordinate system, to type the X and Y
coordinates of a point to be transformed and to interactively view the output
coordinates for the selected point.

Figure 4.4:

The corner of the topomap of sheet “Cochabamba” indicated the grid in UTM 19
coordinates, the tickmarks in UTM 20 coordinates and the upper left corner in geographic coordinates.

First you will check whether the conversion from latitude/longitude to metric
coordinates of a certain UTM zone is correct.

☞

•
•

Select the Input Coordinate System Latlon .

•

Select the Output Coordinate System Cochabamba in the list box Output
Coordinate System.

•

Check the metric coordinates of UTM zone 19 with those in the map in
Figure 4.4. Write them down.

Type the latitude and longitude as indicated in the corner of the map in
Figure 4.4.
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➦

•

Select the coordinate system Cocha20 list box Output Coordinate
System.

•

Check the metric coordinates of UTM zone 20 with those in the map in
Figure 4.4 and write them down.

Now you will check if the conversion of coordinates from UTM zone 20 to 19 is
done correctly.

☞

•

In the Transform Coordinates dialog box select the Input Coordinate
System Cocha20 .

•

Type the X and Y values that have been noted down for the conversion from
Latlon to UTM 20 .

•

Select the coordinate system Cochabamba in the list box Output
Coordinate System.

•

Check the metric coordinates of UTM zone 19 with those that you have written down for UTM 19.

•

Close the Transform Coordinates dialog box.

The calculated coordinates for this point in other projections will be displayed in the
box. You should check the X and Y value with the ones you have noted from the
paper map with the UTM projection. Small differences may occur, due to rounding
errors. If the calculated coordinates are very different, you better check whether the
projection parameters in the input coordinate system are correct. If the calculated
coordinates are the same, follow the next steps to transform the actual map.
Transforming vectors
After checking that the transformation of some known points in two maps with
different projections is done correctly, you can do the actual transformation. In this
example, we have a map City20 , in which the outline of the city of Cochabamba is
digitized in UTM 20 coordinates. This polygon file will be temporarily transformed
to UTM zone 19, for display purposes. There is also a segment map City19 , with
which you can check the result.

☞

•
•
•

Display polygon map City20 . This map has coordinates in UTM 20.

•

Compare the boundaries of the city polygon and segments.

Display segment map City19 . This map has coordinates in UTM 19.
Drag-and-drop polygon map City20 into the map window displaying
City19 .

Now the actual transformation can be done.
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☞

•
•

Close both map windows.

•
•
•

Select the map City20 in the list box Polygon Map.

•

Accept the defaults by clicking the OK button. Polygon map City19 is displayed.

•

Compare the input polygon map City20 with the transformed output polygon map City19 .

•

Check the result by adding segment map City19 to the map window and
zoom in where the lines are doubled.

•

Add gridlines every 1000 meters (in Blue ), and a graticule (in Green )
every 5 minutes.

•

Close the map window when you have finished the exercise.

Double-click Transform Polygons in the Operation-list. The Transform
Polygon Map dialog box is opened.
Select Cochabamba in the list box Coordinate System.
Type City19 in the text box Output Polygon Map and click Show. The
Display Options - Polygon Map dialog box is opened.

Summary: Map projections
- After importing vector maps, their coordinates may not be the ones that you use for
your other maps. In that case you will need to transform the coordinate system. The
most important reason that coordinates may be different (apart from the fact that a
local coordinate system may have been used) is that the original maps had different
projections.
- A map projection defines the relationship between the map coordinates and the
geographic coordinates latitude and longitude.
- Projections are classified according to their class (cylindrical, azimuthal, conical),
their aspect (normal, transverse) and their properties (conformality, equivalence,
equidistance).
- The Universal Transverse Mercator (UTM) projection system, is the projection
used most in GIS and image processing, for relative small study areas. In this
projection the world is divided into 60 zones of 6° of longitude in width.
- Before making a coordinate transformation, it is wise to check the transformation
for a few coordinate pairs. This can be done with the Transform Coordinates
dialog box.
- After checking that the transformation of some known points in two maps with
different projections is done correctly, you can do the actual transformation.
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4.3 Vector data management
A vector map can be obtained either via digitizing a paper map, as was explained in
chapter 3, or from importing digital vector data, as was shown in section 4.1. A
number of tools are available to adapt vector maps for the analysis. In order to be able
to use vector maps of the same area together, all maps should have the same
coordinate system. In the previous section, the transformation from one coordinate
system to another was explained. In this section, a number of tools for further
manipulating vector maps will be shown such as the creation of a sub map,
combining two or more vector maps into one map, copying selected information from
a vector map using a mask, densifying coordinates, or thinning them using tunneling,
editing vector maps, and the conversion from one type to another. The change of the
domain type of the map will be explained in section 4.6.
Creating a sub map
The sub map operation makes it possible to select a rectangular part in a vector map
and save it as a new map. The user has to specify minimum and maximum XYcoordinates for the new segment map. The output segment map can be smaller than
the input map, but it can also be larger.
In this exercise, a rectangular part of the segment map Drainage will be saved as a
new segment map.

☞

•

Expand respectively the Vector Operations item and the Segments item in
the Operation-tree.

•

Double-click SubMap of Segment Map operation. The Sub Map of
Segment Map dialog box is opened.

•
•

Select segment map Drainage in the list box Segment Map.

•

Type 805300 for maximum X and 8083300 for maximum Y in the text box
Max X, Y.

•

Type Drainsub in the Output Segment Map text box and click Show.
The Display Options - Segment Map dialog box is opened.

•
•

Click OK. The map is displayed.

Type 797200 for minimum X and 8078200 for minimum Y in the text box
Min X, Y.

Compare the Drainsub map with the map Drainage and close both map
windows when you have finished the exercise.

Glueing segment maps
This operation merges two or more segment maps of the same coordinate system and
domain together. By default, it copies all segments of the input maps into the output
map, unless a mask to select specific segment codes is specified. The operation also
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creates coordinate boundaries for the output map, based on the minimum and
maximum X and Y coordinates of the input maps. Note: If a user defines coordinate
boundaries that are smaller than the default, all segments of the input maps that fall
within these user-defined coordinates are copied, and the segments outside this
boundary are deleted.

!

The output map of this operation may have double segments, which can be
removed by editing the map (see chapter 3 on editing segments).
The segments that are supposed to continue in two or more sheets are not
automatically connected to each other in the output map. They can be connected
in the Segment editor using the Move Points option.

Suppose you have digitized contour lines for the Cochabamba area from two map
sheets. Now you want to combine them into one single map. Suppose also that you
only want the hundred meter contour lines. This means you have to use a mask.

☞

•

Display segment map Connorth . This segment map contains the contour
lines for the northern part of the study area.

•

Also display Consouth . This map contains the segments for the southern
part of the area.

•

Close both map windows and double-click the item Glue Segment Maps in
the Operation-list. The Glue Segment Maps dialog box is opened.

•
•
•

Select the option 2 for Number of Input Maps.

•

Select the map Connorth and Consouth in the list boxes Map.
Type ??00 in both text boxes Mask. This has the effect that only the contour
lines with 100 meter contour interval are copied.
Select the check box Clip Boundary.

This check box is used when a user wants to specify different coordinate boundaries
for the output map than those of the combination of the input maps. Otherwise, by
default, the output map comprises the whole area of all input maps.

☞

•

Leave the Min X and Max X unchanged and type for Min Y: 8071798 . Type
for Max Y: 8090600 .

•

Type Concomb in the New Domain and the Output Segment Map text
boxes.

•

Type the Description: 100 meter contour lines in the entire
study area and click the Show button. The Display Options - Segment
Map dialog box is opened.

•

Accept the defaults by clicking the OK button in this dialog box. The new
segment Concomb is displayed.

•

Close the map window when you have finished the exercise.
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Masking vector data
This operation allows to selectively copy points, segments, or polygons into a vector
map, by specifying a mask, which lists the names and/or codes that are to be copied.
A mask contains one or more search strings, separated by a comma (spaces before or
after a comma make no difference). Asterisks can be used as a wild card for zero or
more characters (e.g. grass* , forest* or 1* , 2* ). Also question marks may be
used to replace only one character (e.g. the mask ??00 or *00 in a contour map). For
more information, open the ILWIS Help, search for Mask, and open the help topic
How to use masks. See also chapter 7, in which more examples of data retrieval
with a mask will be given.
Any vector map (with domain type class, ID, value) can be used as input map in this
operation. In fact there are three separate operations for points (Mask Points),
segments (Mask Segments) and polygons (Mask Polygons), but they work the
same. The output map uses the same domain, coordinate system and coordinate
boundaries as the input map. In this example, segment map City19 will be used to
extract only the grid lines.

☞

•

Display the segment map City19 , and open the domain to look at the
domain items.

•
•

Close the Domain Class editor and the map window.
Double-click the Mask Segments item in the Operation-list. The Mask
Segments dialog box is opened.

•
•

Select segment map City19 in the list box Segment Map.

•
•

Click Show. The Display Options - Segment Map dialog box is opened.

•

Type Grid19 in the text box Mask and in the text box Output Segment
Map.
Accept the defaults by clicking the OK button in this dialog box. Now only
the grid lines are shown.
Close the map window when you have finished the exercise.

Densify segment coordinates
The operation Densify Segment Coordinates adds extra intermediate coordinates
within segments of an input map, at a user-specified distance, and copies them to an
output segment map. It is advised to use this operation during the Transform
Segments. The segment map Grid19 , which was created in the previous exercise,
will be used as an example. This map contains gridlines, digitized for the
Cochabamba area. Each gridline in the input map is defined by a starting and ending
coordinate.
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☞

•

Double-click Densify Segment Coordinates in the Operation-list. The
Densify Segment Coordinates dialog box is opened.

•
•

Select the map Grid19 in the list box Segment Map.
Type 200 in the text box Distance. An intermediate coordinate will be
added every 200 meters.

•

Type Grid19new in the text box Output Segment Map and click Show.
The Display Options - Segment Map dialog box is opened.

•

Accept the defaults by clicking the OK button in this dialog box. The map is
now displayed. Apparently there is no difference.

•

Close the map window.

In order to be able to compare the output segment map Grid19new with the input
map Grid19 , you need to look at both maps in the Segment editor, which allows
you to see the intermediate coordinates as crosses. The editor can only be used on
maps that are not dependent, so the dependency link should be broken first, for both
maps.

☞

•

Break the dependencies of the maps Grid19 and Grid19new by clicking
the Break Dependency Link button on the Dependency tab of the
Properties sheet.

•

In the Catalog click the map Grid19 with the right mouse button and select
Edit from the Context-sensitive menu. The Segment editor is opened.

•

Zoom in on a part of the map and select the Move Point Mode. As you can
see each gridline only has a starting and ending point. Close the Segment
editor.

•

Click the map Grid19new with the right mouse button and select Edit from
the Context-sensitive menu. The Segment editor is opened.

•

Zoom in on a part of the map and select the Move point mode. As you can
see there are now intermediate coordinates at regularly spaced intervals of
200 meter.

•

Close the Segment editor and the map windows when you have finished the
exercise.

Tunnel segments
This is more or less the opposite of the densify coordinate operations. The aim of this
operation, is to reduce the number of intermediate points and remove superfluous
nodes within segments of the input map. This operation can also be used when you
want to generalize your maps. The principle of tunneling was explained in chapter 3.
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☞

•

Double-click Tunnel Segments in the Operation-list. The Tunnel
Segments dialog box is opened.

•
•
•

Select the map Drainage in the list box Segment Map.
Type 20 (meter) in the text box Tunnel Width.
Type Draintun20 in the text box Output Segment Map and click Show.
The Display Options - Segment Map dialog box is opened.

•
•

Accept the defaults by clicking the OK button in this dialog box.

•

Compare the results by displaying the maps Draintun20 , Draintun50
and Draintun100 in the same map window, and zooming in on a part of
the map.

•

Close the map windows when you have finished the exercise.

Repeat the exercise twice: once with a Tunnel Width of 50 meters (Output
Segment map Draintun50 ), and the other with a Tunnel Width of 100
meters (Output Segment map Draintun100 ).

In ILWIS several other vector operations are possible. An overview is given in table
4.3. For more information see also the ILWIS Help topic Vector operations.
Table 4.3: Overview of vector operations in ILWIS.
Operation

Point

Segment

Polygon

Attribute map

Attribute Map of
Point Map
Mask Points
SubMap of
Point Map
Glue Point Maps
-

Attribute Map of
Segment Map
Mask Segments
Labels to Segments
SubMap of
Segment Map
Glue Segment Maps
Densify Segment
Coordinates
Transform Segments
Tunnel Segments

Attribute Map of
Polygon Map
Mask Polygons
Labels to Polygons
-

Mask
Assign labels
Sub map
Glue map
Densify coordinates
Transform
Tunnel

Transform Points
-

Transform Polygons
-

Creating a polygon map from a segment map
In some cases you may have a segment map from which you want to generate a
polygon map. This may be the case if you have imported a polygon map from
Arc/Info E00 format. The import results in a segment map and a point map,
containing polygon labels.
When you want to generate a polygon map from a segment map, there are two
possibilities:
- Using the Segment editor. This method should be followed when you are not sure
whether the segment map is error free. In the Segment editor you can edit the
144
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segments, make a check of them, and then polygonize them. This method was
explained in section 3.4.
- Using the Segment to Polygon (Polygonize Segment Map) operation. This
method can be followed when you are sure that the segment map is correct. The
advantage of this method is that it can be used in an automated way to periodically
update files.
The last method will be shown.
In this example a segment map Landunit will be used, similar to the map used in
section 3.4. To create a polygon map out of a segment map, all segments in the input
map should be correctly digitized, that means no dead ends, no intersections, no
double segments, etc. The output of this operation is a polygon map using system
domain Unique ID, which contains IDs such as pol 1, pol 2, pol 3,..., etc.

☞

•

Double-click Segment to Polygon in the Operation-list. The Polygonize
Segment Map dialog box is opened.

•
•
•

Select segment map Landunit in the list box Segment Map.

•

Click the Show button. After creating the polygon map, the Display
Options - Polygon Map dialog box is opened.

•
•
•

Click OK to display the map.

Clear the Mask, Topology and Auto Correction check boxes.
Select the option Unique Identifiers and type Landunit in the text box
Output Polygon Map.

Check the meaning of the polygons by clicking them.
Close the map window when you have finished the exercise.

The resulting polygon map uses system domain unique ID, indicating the different
polygons as Pol 1, Pol 2, etc. If you want to change these ID’s, create an attribute
table for the map, create in the table an attribute column with correct (class) names
and create an attribute map.
A better option would be to polygonize the map using label points. The label points
can be generated from another polygon map using the Polygon to Point operation,
or digitized as a point map. In this case a label point map was already made (point
map Landunit ).

☞

•

Double-click the Segment to Polygon operation in the Operation-list. The
Polygonize Segment Map dialog box is opened.

•
•

Select segment map Landunit in the list box Segment Map.

•

Type for Output Polygon Map: Landunit2 and click the Show button.

Make sure the Label Point check box is selected and use the point map
Landunit as Label Points.
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The polygon map Landunit2 is created and the Display Options –
Polygon Map dialog box is opened.

•

Click OK in the Display Options – Polygon Map dialog box. The polygon
map Landunit2 now contains the correct names.

•

Close the map window when you have finished the exercise.

Creating a segment map from a polygon map
The extract boundaries operation creates a new segment map out of a polygon map,
containing all polygon boundaries. The input map for this operation is a polygon map
with any domain type. The output map resulting from the conversion is a segment
map with an internal class domain. The class name of a segment in the output map, is
the combination of the name of the neighbouring polygons. For example, the
boundary between two polygons with the class name Lake and Mountain is
codified in the output segment map as Lake|Mountain .
In this exercise the polygon map Landuse is converted to a segment map.

☞

•

Display polygon map Landuse , and click several polygons to find out their
names. Close the map window.

•

Double-click Polygon to Segment in the Operation-list. The Boundaries
of Polygons dialog box is opened.

•
•

Select the polygon map Landuse in the list box Polygon Map.
Make sure the check box Single Name is cleared. If this check box is selected all segments get the name: Segments .

•

Type Landuse_bound in the text box Output Segment Map and click
Show. After creating the segment map the Display Options – Segment
Map dialog box is opened.

•
•
•

Select the Info check box and press OK.
Click several segments to find out the meaning of the codes.
Close the map window when you have finished the exercise.

Several other conversion options between tables, point, segment and polygon maps
are possible. An overview is given in Table 4.4. The operations are described in the
ILWIS Help topic Vectorize.
Table 4.4:
Data type

Overview of data conversions in ILWIS.
to Point

to Segment

to Polygon

to Table

Open as Table
from Segment Segment to Point
Segment to Polygon
from Polygon Polygon to Point Polygon to Segment
from Table
Table to Point
from Point
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Point maps can be opened as a table, for instance by clicking the right mouse button
on the object and selecting Open as Table in the context-sensitive menu. When you
make the Command line visible in the table window, you can calculate with the
values in the columns.
Summary: Vector data management
The following tools can be used to manage vector data:
- Creating a sub map of a vector map and merging two or more vector maps.
- Selectively copying vector data using a mask.
- Obtain more intermediate coordinates within segments in a segment map using the
Densify Segment Coordinates operation.
- Tunneling reduces the amount of coordinate data stored in a segment map.
- Creating a segment map from a polygon map.
- Assigning labels to segments or polygons.
- Creating an attribute map.
- Glueing of maps.
- Transforming the coordinates of a map into another coordinate system.
- Conversion of one vector data type into another.
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4.4 Vector to Raster conversion
As has been mentioned already in chapter 1, most of the analyses in ILWIS are based
on raster data. Therefore, conversion from vector to raster format (rasterization) is
often a necessary step preceding the analysis. Points, segments and polygons are
represented by grid cells (pixels) in the raster data structure. In order to convert a
map from vector into raster format, a mesh with pre-defined cell size, is laid over the
map. The size of the grid cells is a crucial aspect of the raster data structure.
Before starting the rasterization, a georeference should be created. A georeference
contains the minimum and maximum X and Y coordinates of the raster map, the
number of rows and columns and the pixel size. When rasterizing various maps of the
same area, it is preferred to select the same georeference for them.
The resulting raster maps have the same domain as the corresponding source vector
map. Since the vector to raster operation is basically the same for point, segment or
polygon maps, only the Polygon to Raster operation is shown here.
Creating georeferences
In this exercise the same polygon map will be rasterized three times, using three
different georeferences with different pixel sizes, to show you the effect of the pixel
size on the final result. The three georeferences will have pixel sizes of 10, 25 and
100 meters.

☞

•

Expand the Create option in the Operation tree and double-click the New
GeoReference item. The Create GeoReference dialog box is opened.

•
•
•

Type for GeoReference Name: Cocha10 .
Select the Coordinate System: Cochabamba .
Type for Pixel size: 10 and for the Description: Georeference with 10
meter pixel size .

•

Accept all other defaults and click OK in the Create GeoReference dialog
box.

•

Create also the georeference Cocha25 with Pixel size 25 meters and
Cocha100 with 100 meters Pixel size.

Rasterization of a polygon map
The Polygon to Raster operation, creates a raster map from a polygon map. In this
exercise the polygon map Landuse will be rasterized.

☞
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•

Double-click the Polygon to Raster item in the Operation-list. The
Rasterize Polygon Map dialog box is opened.

•

Select polygon map Landuse in the list box Polygon Map and type
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for the Output Raster Map: Land10 .

•

Select GeoReference: Cocha10 , type Raster map showing land use
in the text box Description and click the Show button in the Rasterize
Polygon Map dialog box. The Display Options - Raster Map dialog box
is opened.

•

Accept the defaults by clicking the OK button of this dialog box. The raster
map Land10 is displayed.

•

Repeat the procedure, and create raster map Land25 with georeference
Cocha25 , and raster map Land100 with georeference Cocha100 .

•

Zoom in on the same part of the map in the three map windows. Drag-anddrop polygon map Landuse to each of the three map windows. Display only
the boundary lines.

•

Compare the three maps and evaluate the effect of different pixel sizes and
close all map windows when finished.

In ILWIS, two other rasterization operations are available, i.e. Point Density and
Segment Density. For each output pixel the total number of points respectively the
total length of segments is calculated. For more information, see the ILWIS Help
topic Rasterize.
Summary: Vector to Raster conversion
- Conversion from vector to raster format (rasterization) is often a necessary step
preceding data analysis.
- Points, segments and polygons are represented by grid cells (pixels) in the raster
data structure.
- In order to convert a map from vector into raster format, a mesh with pre-defined
cell size is positioned over the map. The size of the grid cells is a crucial aspect of
the raster data structure.
- Before starting the rasterization, a georeference should be created. A georeference
contains the minimum and maximum X and Y coordinates of the raster map, the
number of rows and columns and the pixel size.
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4.5 Raster data management
A raster map can be obtained either via rasterizing a vector map, as was explained in
the previous exercise, or from importing raster data, as was shown in section 4.1. A
number of tools are available to adapt raster maps for the analysis. In order to be able
to use raster maps of the same area together, all maps should have the same pixel
size, and the same number of rows and columns. In this section a number of tools for
manipulating raster maps will be shown, such as the creation of a sub map,
combining two raster maps into one map, mirroring and rotating maps, resampling
maps, editing raster maps, and the conversion from raster to vector.
Creating a sub map of a raster map
The sub map operation allows you to specify a rectangular part of a raster map and
copy it into a new raster map. You can specify corners either in row and column
numbers or in XY-coordinates. A raster map with any type of domain can be used as
input. The output map uses the same domain as the input map. The operation
automatically creates a new georeference for the output map. This operation is very
useful for creating subscenes from an entire frame of a satellite image, only covering
the area of interest.
In this exercise, a selected window of a hillshading map of a part of South America
(Hillshad ) will be saved as a new raster map (Hillshad_sub ). We also have a
map Bolivia_mask , containing only the country of Bolivia. From this image the
area that has to be extracted can be found.

☞

•

Open the map Bolivia_mask , and find out the area that should be extracted (expressed in first line, first column, nr. of lines, nr. of columns).

•

Close the map window and double-click the SubMap of Raster Map operation in the Operation-list. The Sub Map of Raster Map dialog box is
opened.

•
•
•
•

Select raster map Hillshad in the list box Input Raster Map.

•

Type for Output Raster Map: Hillshad_sub and click the Show button.
The map is created and the Display Options – Raster Map dialog box is
opened.

•

Click OK in the Display Options - Raster Map dialog box and close the
map window after you have seen the result.

Make sure the Lines and Columns option is selected.
Type 300 in the text box First Line and 375 in the text box First Column.
Type 670 in the text box Number of Lines and 650 in the text box Number
of Columns.

You can use the same method to extract the same area from the map Bolivia_mask ,
and then create a final map only showing the hillshading for the country of Bolivia.
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Glueing raster maps
The Glue Raster Maps operation merges two or more georeferenced raster maps.
The input maps should have a georeference and a domain which can be merged. The
input maps can have different georeferences, coordinate systems and pixel size. In the
case of different georeferences, the output map will use the georeference of the first
input map. If needed, the second, third etc. input map will then first be resampled to
the georeference of the first input map. If the georeferences of the input maps have
different coordinate systems, the coordinate system of the second, third etc. input
map will be transformed into the coordinate system of the first input map. In the
resampling process, the size of the pixels in the second, third etc. input map will be
adjusted to the size of the pixels in the first input map, if they are different.
If the maps have different domains, the possible combinations for merging input
domains, are given in the Table 4.5. See the ILWIS Help topic Glue raster maps for
more information.
The output map is sized to allow all maps to fit in. In this way, you can glue adjacent
or partly overlapping georeferenced raster maps, derived from different sources. The
output map uses a new georeference in which all input georeferences fit. The map
uses the coordinate system and pixel size of the first input map. It is, therefore,
important to make a careful choice of the input map.
In case input maps overlap, users can define from which map the pixel values should
be used for the overlapping parts. By default, the pixel values of the first input map
are used.
Table 4.5:

unique ID
ID
class
value
bool
image
color
picture
bit

Possible combinations of domains of input raster maps and the resulting domain of
the output raster map.
unique ID

ID

class

value

bool

image

color

picture

bit

unique ID
ID
ID
-

ID
ID
ID
-

ID
ID
class
color
class
color
color
color
color

color
value
value
value
color
color
value

class
value
bool
value
color
color
bool

color
value
value
image
color
color
value

color
color
color
color
color
color
color

color
color
color
color
color
color
color

color
value
bool
value
color
color
bit

In this exercise two parts of a TM image, one covering the northern (Tmb1_north )
and the other covering the southern part (Tmb1_south ) of the study area, are glued
together. Both maps have the image domain.

☞

•

Double-click the Glue Raster Maps operation in the Operation-list. The
Glue Raster Maps dialog box is opened.

•

Select raster map Tmb1_north in the list box 1st Map.
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•
•
•

Select raster map Tmb1_south in the list box 2nd Map.
Type Tmb1_combined in the text box Output Raster Map.
Click the Show button. The map is created and the Display Options –
Raster Map dialog box is opened.

•

Click OK in the Display Options - Raster Map dialog box. The map is
shown.

•

Display also the raster maps Tmb1_north en Tmb1_south and close the
map windows when you have finished the exercise.

If you select the Last Map on Top check box, the values of the pixels defining the
overlap are taken from the second input map. Clear this check box if these values
should be taken from the first input map.
Mirror rotate
The Mirror Rotate operation allows you to mirror a raster map in a horizontal,
vertical, or diagonal line, to transpose (switch) the map’s rows and columns, or to
rotate a raster map 90°, 180°, 270° (clock-wise). There are no special requirements
for the input map. The output raster map uses the same domain as the input raster
map. The operation creates a new georeference for the output map which obtains the
same name as the output map. The new georeference depends on the georeference of
the input map. This operation may be needed if you get an input raster map from
another source, which is rotated or mirrored. For example, when you use a scanned
image and the image was not properly oriented on the scanner. As an example there is
a 3D view, which is upside down.

☞

•
•

Display the map View3D and close the map window again.

•

Select raster map View3D in the list box Raster Map and select the option
Mirror Horizontal.

•
•
•

Type View3D_ok in the text box Output Raster Map.

•
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Double-click Mirror Rotate in the Operation-list. The Mirror Rotate dialog box is opened.

Click Show. The map View3D_ok is created
Click OK in the Display Options - Raster Map dialog box. The map is displayed now in the correct form.
Close the map window when you have finished the exercise.
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Resampling
In many cases, the raster operations shown above will not be sufficient to get your
imported raster data in the correct form, to combine them with other maps. The pixel
size may be different from the other maps, or the map may lack coordinates. To
overcome these problems, the map should be resampled to another existing raster
map in your data base. Resampling will be explained in more detail in chapter 6,
dealing with image processing. Here it is important to note that many of the tools,
originally designed for image processing, are equally valuable when working with
other types of raster maps.
Suppose that you have received a geological map from someone else. Suppose that
apart from the digital file you also received a table with a series of control points. If
these were missing you would have to find out control points yourself by comparing
the raster map with a topographic map, or with another digital map. This is shown in
chapter 6. Here it is assumed that 10 control points are known. The next thing to do is
to make a georeference for this map, using the control points listed in Table 4.6.

☞

!

•
•

Open raster map Geology .

•
•
•

Type for the GeoReference Name: Geology .

•

From the Edit menu in the GeoReference Tiepoints editor select Add Tie
in the Toolbar of the editor.
Point or press the Add Tie Point button
The Add Tiepoint dialog box is opened.

•

Type the Row , Column , X and Y coordinates for the first point as shown in
Table 4.6.

•

Repeat this for the other 9 tiepoints. The transformation should display
Affine, and the Sigma (the error) should be lower than 1.

•

Close the GeoReference Tiepoints editor by clicking the Exit Editor button
. Raster map Geology is now georeferenced.

•

Close the map window.

From the File menu of the map window select Create, GeoReference. The
Create GeoReference dialog box is opened.
Accept the default option GeoRef Tiepoints.
Select the Coordinate System: Cochabamba and click OK. The
GeoReference Tiepoints editor is opened.

If a digital table with tiepoint data is available, you can also use Copy and Paste
to insert your data in the Georeference Tiepoints editor.
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Table 4.6:

Tiepoint locations for the raster map Geology.

X

Y

Row

Column

797955
804195
804915
797415
800078
802343
800835
796455
796050
802973

8088615
8087085
8080185
8080335
8083830
8081985
8073450
8072865
8083628
8089080

127
229
689
679
446
569
1138
1177
460
96

165
581
629
129
306
457
357
65
38
499

Now that the raster map Geology is georeferenced, you can resample it to another
raster map, for example Landuse , which uses the georeference Cochabamba .

☞

!

•

Double-click Resample in the Operation-list. The Resample Raster Map
dialog box is opened.

•
•
•

Select raster map Geology in the list box Input Raster Map.

•

Click OK in the Display Options - Raster Map dialog box. The map which
is now displayed has the same pixel size and the same number of rows and
columns as the raster map Landuse .

•

Close the map window when you have finished the exercise.

Type for Output Raster Map: Geolout .
Select the GeoReference: Cochabamba make sure the resampling method
Nearest Neighbour is selected and click the Show button. The map
Geolout is calculated.

If you want to practice some more with resampling, you can generate control
points from the polygon map Cityblock (city blocks of Cochabamba), and use
these to georeference the raster map Airphoto (scanned aerial photograph of the
center of Cochabamba). Then rasterize the polygon map Cityblock (with a
pixel size of 5 meters) and resample the map Airphoto .

Editing raster maps
Maps may contain errors, which are introduced during digitizing, or which are in the
original imported data coming from other packages. Maps also need to be updated
when changes have occurred in an area, for example when the land use has changed.
In those situations you will need to edit the maps. When you use the Pixel editor you
can change the value, IDs or class name of pixels in a raster map. In the Pixel editor,
only the mouse pointer can be used, not the digitizer cursor.
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Editors can only be used to edit source maps. Dependent maps (e.g. the raster map
created by rasterizing a polygon map) and maps which are defined in their properties
form as read only, cannot be edited. Conceptually, it would not be a good idea to edit
a dependent map, since such a map is derived from source maps, which are not
changed in that case. To edit a dependent map, you should either edit the source
map(s) and use the Make Up to Date button in the dependent map’s Properties
sheet or you should break the dependency. To edit a read only map, clear the ReadOnly check box in the Properties sheet of the read-only map.
Editing raster maps using the Pixel editor is only useful if you want to make
relatively small changes to a raster map. Since you can only edit pixel by pixel
(including the possibility to select multiple pixels, and rectangular groups of pixels),
changing irregular shapes in a raster map is rather time consuming. In that case it
would be better to convert the raster map to vector (as will be explained in the next
exercise) and do the editing in the Segment editor. Another option would be to
digitize the areas that should be changed as lines or polygons, rasterize these vector
maps and use them in a map calculation statement to mask away the wrong areas in
the raster map. In this exercise you will edit a raster map (called Wrong ) with a class
domain.

☞

•

Display the raster map Wrong . As you can see there is a part that needs to be
edited: the word EDIT .

•

From the Edit menu in the map window, select Edit Layer, and 1 map
Wrong . The Pixel editor is opened.

•
•

Zoom in on the word EDIT and click the Normal button.

•

Press the right mouse button and select Edit from the Context-sensitive
menu. The Edit dialog box is opened.

•
•

Select for Class Name: Class 2.

Select with the left mouse button a part of the letter E which is surrounded
by green pixels by dragging a box.

To see the result press the Redraw button in the Toolbar of the Pixel editor.

In the Pixel editor, you can select one or more pixels by clicking them or dragging a
box around them, in order to change their class name, ID, or value. You can add
pixels to a selection, clear a part of a selection or toggle between select and deselect
pixels.
- To add pixels to a selection:
Press and hold the CTRL key and click the other pixels you want to select.
- To clear a part of a selection:
Press and hold the CTRL+SHIFT keys, then click previously selected pixels or
drag a box around them.

ILWIS 3.0 User’s Guide

155

Spatial data management
- To toggle between selecting and deselecting pixels:
Press and hold the SHIFT key, then click pixels or drag a box around pixels
(selected pixels are deselected and non-selected pixels are selected).

☞

•

Practice with these various options. Edit the map so that the word EDIT is
replaced by the pixel values of the areas surrounding it.

•
•

Exit the Pixel editor by pressing the Exit Editor button.
Close the map window when you have finished the exercise.

Raster to Vector conversion
Sometimes it can be necessary to convert raster maps back to vector maps. This can
be the case if you obtain a thematic raster map by importing a digital file from other
sources. If you want to edit the map extensively, it is better not to do that with the
Pixel editor. It is best to convert the raster map to polygons first, then extract
segments and create labels, and do the editing in the Segment editor, after which
you polygonize and rasterize the map again. It may also be useful to convert raster
maps back to vector maps if you want to use them for high quality map production.
To convert raster data to vector data format, a 3x3 matrix moves over the input map
and assigns a code (class name, ID or value) to the center pixel of the matrix in the
output map, which depends on the class name, ID or value of the center pixel and its
4 or 8 neighbours. See chapter 9 for more information about 4 or 8-connectivity.
Undefined pixels will not be vectorized. The result of the conversion depends on the
homogeneity of the raster map and the pixel size compared to the size of the mapping
units. The program is provided with a smoothing facility, to remove the sharp corners
formed by the boundaries between mapping units of the raster map. Automatic
tunneling (see chapter 3) is performed on the coordinates of the vector data to delete
the redundant ones. In this exercise the raster map Slopeclass is converted to a
polygon map.

☞

•

Double-click the Raster to Polygon operation in the Operation-list. The
Polygons of Raster Map dialog box is opened.

•
•
•

Select raster map Slopeclass in the list box Raster Map.

•
•
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Accept the defaults for connectivity and smoothing.
Type Slopeclass in the text box Output Polygon Map, type Polygon
map slope classes in the text box Description and click Show. The calculation will take some time. After that the Display Options - Polygon
Map is opened.
Accept the defaults by clicking the OK button. The polygon map is shown.
Close the map window when you have finished the exercise.
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Now you will see the effect of converting a raster map to segments. When you convert from raster to segments, only the boundary lines between mapping units are
stored, but in such a way that it is still possible to find out what the mapping units on
both sides of the line are.
The output map resulting from the raster to segment conversion uses a unique ID
domain and an attribute table with 3 columns: Area1 , Area2 and Length . Area1
and Area2 have the domain of the input raster map and indicate the right and left
area. The column Length gives the length of the segment. For example, Boundary1
is the segment between an area with class a and an area with class b (Figure 4.5).

Figure 4.5:

☞

Conversion of a raster map to a segment map (see the text for explanation).

•

In the Catalog, click with the right mouse button on raster map
Slopeclass and select Vectorize, Raster to Segment.
The Segments of Raster Map dialog box is opened.

•
•

Make sure the check box Single Name is cleared.

•

Click the Show button. The segment map Slopeseg is calculated and the
Display Options - Segment Map is opened.

•

In the Display Options – Segment Map dialog box, select the Info check
box and click OK.

•

Find out the class names of the segments via the attribute table Slopeseg
and close the map window when you have finished the exercise.

Type Slopeseg in the text box Output Segment Map and type Segment
map slope class in the text box Description.
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Summary: Raster data management
The following tools can be used for raster data management:
- Copying a rectangular part of a raster map into a new raster map, using the
SubMap of Raster Map operation.
- Merge raster maps (Glue Raster Maps operation).
- Mirror, transpose or rotate a raster map (Mirror Rotate operation).
- Resampling a raster map to another georeference (Resample operation).
- Editing a raster map using the Pixel editor.
- Converting a raster map to a point, segment or polygon map (Raster to Point,
Raster to Segment, Raster to Polygon operations).
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4.6 Domain conversion
In the previous exercise, especially during the exercise dealing with import, you have
seen that in ILWIS your map may have another domain than you would like.
Sometimes the domain of a map should be changed, e.g., converting a domain value
to a domain class. In this exercise the various methods for domain conversion are
treated.
A warning about changing domains
Apparently the easiest solution for changing the domain type would be to simply
change the domain in the Properties sheet of the map. This should be done with
care! This method is only recommended for converting between domains of the same
type (e.g. for converting a class domain Landuse to a class domain Landuse1 ). You
should make sure, however, that the two domains have the same ordering of the raw
values. If the ordering is different, than the names in the map will be mixed after
changing the domain.
Changing domains of maps via the Properties sheet, is not recommended for
changing from one domain type to another (e.g. from domain class to domain value).
If you do that your file may become corrupt. For changing domain types, follow the
guidelines described below.
Conversion between an ID domain and a class domain
Class domains and identifier domains are not so different. It is, therefore, easy to
convert from one type to the other. The conversion from a class domain to an
identifier domain can be done by clicking the button Convert to classes in the
Properties sheet of an ID domain. The conversion from a class domain to an
identifier domain can be done by clicking the button Convert to identifiers in the
Properties sheet of the class domain.
Take for example the polygon map Landuse , containing the land use types in the
study area. This is a class map.

☞

•

In the Catalog, click the domain Landuse with the right mouse button and
select Properties. The Properties sheet is opened. As you can see the
domain contains 12 domain items.

•

Press the Convert to identifiers button. The class domain is converted to an
identifier domain.

•

Open the Properties sheet of the domain Landuse again. Now you can see
that it reads: Domain Identifier “Landuse”.

•

Press the Convert to classes button. The ID domain is converted back to a
class domain.
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The conversion from classes to identifiers is not very logical for the map Landuse ,
since each land use class contains various polygons. An identifier domain is generally
useful if each domain item is linked to one map feature (point, segment, polygon, or
group of connected pixels in a raster map).
There is, however, a way to convert a class map to a unique ID map, using the
Unique ID operation. This operation can be used to give a unique ID to all features in

a segment, polygon or point map. The results of the operation are a map and an
attribute table with the same name. The output map uses the system domain Unique
ID. The output table has the same domain as the output map and consists of two
columns, containing the original class names and the areas of each polygon. The
information in the column consists of the classes, IDs or values of the original map
per ID in the output map.

☞

•

Double-click Unique ID in the Operation-list. The Unique ID dialog box is
opened.

•
•
•

Select polygon map Landuse in the list box Input Map.

•

Click OK to display the map and click the polygons in the map window to
view the IDs.

•

Open the table Landid to view the original class name of the polygons and
the assigned ID.

•

Close the map window and the table when you have finished the exercise.

Type Landid in the text box Output Map.
Click the Show button. The map Landid is made and the Display Options
– Polygon Map dialog box is opened.

The Unique ID operation can only be performed on vector maps. The equivalent
operation for raster maps is called Area Numbering, which will be treated in
Chapter 9.
Converting a class or an ID domain to a value domain
The conversion from a class or an identifier domain to a value domain, can best be
done by creating an attribute map from a value column of the map’s attribute table.
Take for example the map Cityblock , which is a map using an identifier domain,
in which each building block of the city of Cochabamba has a separate code. Linked
to that map is an attribute table Cityblock which contains, amongst others,
information on the number of persons living in each cityblock (column
Population ).

☞
160

•

Open the polygon map Cityblock and double-click some units to find out
the information from the attribute table Cityblock .
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In this case the conversion from identifier to value only makes sense when you want
to create for example a population map.

☞

•
•

Close polygon map Cityblock .
In the Catalog click polygon map Cityblock with the right mouse button
and select Vector Operations, Attribute Map in the context-sensitive
menu. The Attribute Map of Polygon Map dialog box is opened.

•

Select the Attribute: Population and type for Output Polygon map:
Population .

•

Click Show. The map Population is created and the Display Options dialog box opened.

•
•

Click OK to display the map.

•

Close the map window and the Properties sheet.

The map Population is a value map. Check this by looking at the
Properties sheet of the map Population or by clicking some units in the
map.

The simple conversion of the map Cityblock from identifier to value domain
would make no sense. If you do that the values have no logical meaning, and besides
that, the map can no longer be linked to an attribute table.
Converting a value domain to a class or an ID domain
The conversion from a value or an image domain to a class domain may sometimes be
necessary. For example, when you have imported a scanned thematic map as a gray
scale TIF file. When you want to convert from a value map to a class map, you should
know the names of the legend units that should be assigned to the different values.
For the conversion from a value map to a class or ID map, there are two possibilities:
- When you have a value map that has values with a precision other than 1, you
should create a group domain (in which the boundary values and the class names
are indicated) and use the Slicing operation as described in chapter 7. An example
of this is the classification of a Digital Elevation Model into a classified altitude
map.
- When you have a value map that has values with a precision of 1, which actually
display thematic information instead of measured data, the procedure is as follows:
1. Create an ID domain with a sufficient number of items.
2. Change the domain from value to the ID domain in the Properties sheet of the
map.
3. Edit the domain while keeping the map open.
4. Convert the IDs to classes if necessary.
This is illustrated with a map that was imported as if it had an image domain. It is,
however, not an image but a class map with information on land use types.
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Table 4.7:
ID

nr
nr
nr
nr
nr
nr
nr
nr
nr
nr
nr
nr

☞
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Relation ID and Class names.
Class name

1
2
3
4
5
6
7
8
9
10
11
12

Agriculture
Agriculture (irrigated)
Airport
Bare rock
Bare soils
Forest
Grassland
Lake
Riverbed
Shrubs
Urban centre
Urban periphery

•

Open the raster map Landimage and click some pixels in the map. As you
can see the map displays numbers instead of class names.

•

Close the map window and select Create, Domain from the File menu in
the Main window. The Create Domain dialog box is opened.

•

Type for the Domain Name: Luse . Select the option Identifier, and type for
the Nr of items: 12 .

•

Accept the default Prefix and click OK. The Domain Identifier editor is
opened. No changes will be made now.

•

Close the Domain Identifier editor and open the Properties sheet of map
Landimage .

•
•

Select Domain Luse and click OK in the Properties sheet.
Open the map Landimage and the domain Luse . Click a unit to find out its
ID. Change the name of this ID to the class name, according to Table 4.7.

•

Change all the domain items and replace them by the land use type,
according to Table 4.7.

•
•

Close the Domain Identifier editor and the map Landimage .
Open the Properties sheet of the domain Luse and press the Convert to
classes button. Now a representation is also created with the same name as
the domain.

•

You can edit the representation and the conversion from value to classes is
ready.

•

Open the map Landimage look at the result and close it afterwards.
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Converting a picture domain to a class domain
The conversion from a picture domain to a class domain, can be done by clicking the
button Convert to Classes in the Properties sheet of the domain. If you want to
convert a picture domain to an identifier domain, you first convert the picture domain
to classes and then press the button Convert to Identifiers in the Properties sheet
of the class domain.
This type of conversion is also quite common, after importing a Windows bitmap
.BMP or .TIF file. Similarly for the conversion from value to class, you should know
which pixel values represent which classes.
This is illustrated with map Landpicture that was imported with a picture domain.
It should be a class map, with information on land use types.

☞

•

Double-click raster map Landpicture . In the Display Options – Raster
Map dialog box select the check box Info and click OK.

•

Click some pixels in the map. As you can see the map displays a combination
of Red, Green and Blue instead of class names.

•

Close the map window and open the Properties sheet of the domain
Landpicture .

•
•

On the Properties sheet, press the button Convert to Classes.

•

Change all the domain items and replace them by the land use type according
to Table 4.7. Deleting the domain items that are not used is not necessary.
Close the Domain Class editor.

•

Now you can edit the representation and the conversion from picture to
classes is ready.

•

Close the map window.

Open the map Landpicture and the domain Landpicture . Click a unit
to find out its class name.

Converting a picture domain to an image domain
The conversion from a map with a picture domain to an image (or value) domain may
sometimes be necessary. For example, the import of TIF color files or BMP files
results in a picture domain for the output map, while in fact it should be value (in the
case of a slope map for example), or image (in the case of a satellite image). So the
conversion from picture to value, or to image, may happen quite often.
A recommended way to convert a map with a picture domain to another map with an
image domain is to use Map Calculation. On the Command line of the Main
window, type a statement like:
MapImage = MapPicture
Where MapPicture is the name of the map with the picture domain and MapImage
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is the name of the output map. In the Raster Map Definition dialog box that follows
directly after you typed the statement, select the system domain Image.
The conversion can also be done by changing the domain type in the Properties
sheet. This can be demonstrated with the hillshading map of Bolivia (Hillshad ),
which was imported in section 4.1 from Windows bitmap .BMP format. This map
has a picture domain. It will be converted to an image domain.

☞

•

Open raster map Hillshad , check that it has a picture domain and close the
map window.

•

In the Catalog, click raster map Hillshad with the right mouse button and
select Properties from the context-sensitive menu. The Properties sheet is
opened.

•
•

Select Domain Image and click OK in the Properties sheet.

•

Close the map window when you have finished the exercise.

Open raster map Hillshad again. From the Display Options – Raster
Map dialog box you can see that the map has domain Image .

Converting a color domain to a value domain
Finally, there is a possibility that you have imported a 24 bits/pixel Windows bitmap.
This is converted in ILWIS to the color domain. The colors of a map with a color
domain, can only be seen correctly when your screen uses a 24 bits/pixel display
(millions of colors). You can convert maps with a color domain easily to an image
domain, with the Color Separation operation.
An overview of domain conversions in ILWIS is given in Table 4.8. For more
information see also the ILWIS Help topic How to change the domain of a map.
Table 4.8:

Domain conversions in ILWIS.

From

To

Recommended procedure

Class
Class or ID
Color
ID
Picture
Picture
String column

ID
Value
Image
Class
Value
Class
Class or ID

Value
Value*

Class
Value

Properties, button Convert to identifiers
Attribute table/column → Attribute Map
Color Separation
Properties, button Convert to classes
Map Calculation
Properties, create class domain, button Convert to classes
Column Properties, button Create new Domain from Strings in
column
Slicing or Properties, select or create new domain
Map calculation

* Domain type value includes all value domains (e.g. system domains Image, Radar, Bool, Bit, etc. and
your own value domains).
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Summary: Domain conversion
You should be careful when changing the domain of a map. If you do not follow the
guidelines described in this section, the file may get corrupt.
The following domain conversions are possible in ILWIS:
- Conversions between class and ID maps, is easily done by pressing the Convert to
Identifiers button or the Convert to Classes button, in the Properties sheet of
the domain.
- Conversion from class or ID to value, is done by creating an attribute map with a
value column from an attribute table.
- Conversion from a value domain to a class/ID domain, can be done either by using
the Slicing operation (when the value map has a precision other than 1), or by
creating an ID domain, and replacing this in the Properties sheet of the map
(when the value map has a precision of 1).
- Conversion from a picture domain to a class domain can be done, by pressing the
Convert to Classes button in the Properties sheet of the domain. Conversion to
ID domain can then also be done (see above).
- Conversion from a picture domain to an image or value domain can be done, by
using a Map Calculation or by changing the domain in the Properties sheet of
the map.
- Conversion from a color domain to an image domain can be done with the Color
Separation operation.
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